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Motivation
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Observations

WYSIWYG editors provide plenty of distractions that compete for your attention.
» That attention is key to good writing.

» These distractions slows down the writing process.

WYSIWYG editors provide little help managing references of any kind.
WYSIWYG editors generally encourage bitmapped graphics.
WYSIWYG editors tends to result in little consistency in the produced documents.

The formats employed by WISIWYG editors are usually horrible in terms of version
control.

WISIWYG editors are usually horrible for collaborative editing.
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Why BTEX? [1/2]

IATEX is a programming language saved in clear text files using markup code.
» This makes it suitable for version control.
» Version control is a form of collaborative editing.

» Web-based editors (like overleaf) exists and work fairly well.

IATEX (mostly) decouples structure and presentation.
P This results in highly consistent layouts.
» When writing, you can focus on the structure.
> If you wish to, you can choose to dig into the nitty gritty details.

> But there is rarely a need: Most templates make the result look great without
intervention.
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IATEX is a highly extendable and mature system with lots of tools designed for technical

documents.
» Working with a bibliography is trivial.
» Working with an index is trivial.
» Working with floats (like figures and tables) is trivial.
» Working with equations is simple.
>

References to any of these just work.



Why BTEX? [2/2]

IATEX is a highly extendable and mature system with lots of tools designed for technical
documents.
» Working with a bibliography is trivial.
» Working with an index is trivial.
» Working with floats (like figures and tables) is trivial.
» Working with equations is simple.
P> References to any of these just work.

IATEX is a professional typesetting system and thus vector based.
» It is trivial to include vector graphics.

> But it is also trivial to include bitmapped graphics.



Why BTEX? [2/2]

IATEX is a highly extendable and mature system with lots of tools designed for technical
documents.
» Working with a bibliography is trivial.
» Working with an index is trivial.
» Working with floats (like figures and tables) is trivial.
» Working with equations is simple.
P> References to any of these just work.

IATEX is a professional typesetting system and thus vector based.
» It is trivial to include vector graphics.

> But it is also trivial to include bitmapped graphics.

Note: This essentially mitigates the observations.



What is IKTEX?
IATEX is a programming language that, when evaluated, produces a PDF file.
It relies heavily on the concept of macro expansion.

IATEX is extended through packages. Currently there are 6000" such packages on
CTAN:

https://ctan.org


https://ctan.org
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What is BTEX? > Styles

In IATEX, contents and presentation are (mostly) separate.

During your day-to-day writing you care about structure: Sections, paragraphs,
emphasis, listing ..

You don’t care about how these are effectualized: Margins, fonts, colors, spacing,
indents ...

These things are (generally speaking) covered by a style, and it typically does a very
good job.

Should you be unhappy with the styling rules defined in your style, then you can:
1. Pick another.
2. Adjust it.
3. Hardcode specifics.



When to Not IATEX?

» Note Taking | find that markdown fulfills this role adequately, and is faster to
write.

» Audience Expectations Often, your audience will expect a Word file, and then it
just doesn't make sense.

» Collaborator Skill Set Often, your collaborators won't be familiar with IATEX,
and then it simply isn't on the path of least resistance.

> Web It it has to go on the web, something that was originally meant for HTML
production is likely the way to go.
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Building the PDF
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Options:
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Engines

In order to compile a IATEX document into PDF you need a IATEX engine.

Options:

» pdflatex The old engine that is fast but lacks native unicode and modern
OpenType font support. These are not serious restrictions.

> xelatex A more modern version of pdflatex that fixes its downsides. But on the
flipside it is slower and has not been actively developed since 2017.

» Jualatex The most modern engine is scriptable through Lua. It also fixes the
issues with pdflatex and is under active development. It is even slower though.

>
>
| 4

This is the way to go for new projects.

From this point on, we will assume lualatex.

Don't worry too much about the lack of speed. It is rare that it becomes an
annoyance.

While you can script it in Lua, the interactions with the IKTEX macro system are
complex. Personally, | have decided against it.



Distributions

For you to work with IATEX, you will need:
» A number of appropriate fonts.
> A IATEX engine for compiling.
» A collection of packages with extensions.

» A number of other support programs.

All of this combined is referred to as a IATEX distribution.



Distributions

For you to work with IATEX, you will need:
» A number of appropriate fonts.
> A IATEX engine for compiling.
» A collection of packages with extensions.

» A number of other support programs.

All of this combined is referred to as a IATEX distribution.

There exists a number of precompiled distributions:
» TgeX Live The typical distribution (Linux, Windows and OSX).
» MiKTeX If you are on Windows (but also works in Linux and OSX).
» MacTeX If you are on a Mac.



Commandline

Running the IATEX interpreter is done using the following command:
lualatex document.tex
or, if you are using minted for source code highlighting:

lualatex -shell-escape document.tex

Note: When using references, you may have to run the command multiple times.



Overleaf
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@ Sign up with Google) (@ Sign up with ORCID

OR

i Enter your email l i Enter your password ]

Sign up for free

By registering, you agree to our terms of service and privacy. notice.

e —r— B

YL R 2 Recompile ~

Computational Techniques in Astronomy!



Overleaf
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\begin{equation}
frac{d}{dt) \left( \frac{\partial \mathcal{L}}{\partial
\dotla}_i}\right) - \frac{\partial \mathcal{L}}{\part]
\end{equation}

\section(Case Study: Inage Analysis of Galactic Structures

Fm

\begin{Figure} [h]
\centeri
\includegraphics[width=g.8\Linewidth] {galaxy. jpe}
\caption{View of the Milky Way Galaxy}
\label{fig:galaxy-Figure}

\end{figure}

\subsection{Inage Processing Algorithms}

Q@submit  Distory

2 Recompile -

Exploringthe Nexus of Astronomy and Computing

P
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Overleaf > Hosting Options

Cloud:
» Paid and free tier.
» Paid tier provides GIT support.

P Issues with uptime.

Self-hosted:
» No GIT support.

> But if all else fails, you can pull the data out yourself.



Building with Make

TARGETS = \
introduction_presentation.pdf \
intermediate_presentation.pdf \

INTRODUCTION_DEPS = \
./figs/vector.pdf \

INTERMEDIATE_DEPS = \
../src/table_heatmap/code.txt \
../src/table_heatmap/code.tex \
figs/sdi.tex \
.intermediate.timestamp \

all: ${TARGETS}
clean:
touch ${TARGETS}

m ${TARGETS}

mrproper: clean
touch dummy~ d.aux d.log d.nav d.out d.snm d.toc d.vrb d.minted

m *~ *.aux *.log *.nav *.out *.snm *.toc *.vrb *.minted
.intermediate.timestamp: ../bin/generate-tex-includes intermediate_*.tex ./figs/vector0.svg
cd .. ; ./bin/generate-tex-includes PDF doc/intermediate_presentation.tex doc

touch .intermediate.timestamp

./figs/vector.pdf: ./figs/vector.svg
inkscape ./figs/vector.svg -z -D -o ./figs/vector.pdf

./figs/vector0.svg: ../bin/process-vector.py ./figs/vector.svg
 /bin/process-vector.pv
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Versioning with GIT

GIT is used for keeping tract of revisions of (primarily) human-readable files.
This is usually used for program code.

IATEX is a programming language, and when we execute IATEX code (through an
interpreter) then we get a PDF file.

A GIT repository can easily contain both your program code and your report.

Typical structure:
» Program code in /src of the repository.
P> Report and presentation in /doc of the repository.

» Figures shared between report an presentation in /doc/figs of the repository.
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Basics



Overall Structure

\documentclass[adpaper, oneside]{memoir}
Preample
\begin{document}

Front Matter

Main Matter

Back Matter

\end{document}



Overall Structure > Packages

A package is a IATEX term for a file (or collection of files) that contain a set of macros
(commands and environments) for dealing with a specialized topic.
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Overall Structure > Packages

A package is a IATEX term for a file (or collection of files) that contain a set of macros
(commands and environments) for dealing with a specialized topic.

The dirtytalk package gives access to the \say command. This command takes one
parameter and wraps it in the proper quotation marks, like “so".

It can be included by putting the following in the preample:
\usepackage{dirtytalk}

This is a very simple package. Others — like TikZ and minted — are much more
extensive.
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All of this goes into the preample.
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Overall Structure > Language and Hyphenation
All of this goes into the preample.

Most parts of IATEX has multilingual support, selectable through the babel package:

/4 use english text to ToC, sections, figures ...
\usepackage [english]{babel}

Custom hyphenation rules can be added:

\usepackage{hyphenat}
\hyphenation{al-go-rithm me-cha-nics}



Overall Structure > File Inclusion

As programmers, we usually have a good understanding of the problems that can stem
from having all of our code in a single file.

In IATEX one can, in essence, include the contents of an other file like so:

\input{filename.tex}

This is often used for top-level sections or figures.
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Overall Structure > File Inclusion

As programmers, we usually have a good understanding of the problems that can stem
from having all of our code in a single file.

In IATEX one can, in essence, include the contents of an other file like so:

\input{filename.tex}

This is often used for top-level sections or figures.

As programmers, we rarely have a good understanding of the problems of having all of
our code split across an ocean of files.

So, use with care.
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Overall Structure > Structure of Contents

The main matter is split into a section tree, with lists of paragraphs as leaves.
What is available to you depends on your style.

\part{Reasoning}
\chapter{Introduction}

paragraph 1
paragraph 2

\section{Problem}
\section{Approach}
\chapter{Analysis}
\section{Themes}
\subsection{Build Systems}
\subsection{Scripting}
\section{Sub-Conclusion}



Commands and Environments

A command is a macro that can be expanded by writing its name prefixed y a
backslash and with parameters, each in a set of curly braces:

\say{Hello, World}



Commands and Environments

A command is a macro that can be expanded by writing its name prefixed y a
backslash and with parameters, each in a set of curly braces:

\say{Hello, World}

An environment is another form of macro, that can be expanded by wrapping code in a
\begin and an \end command like so:

\begin{center}
Some text.
\end{center}
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Either there is at least one, or there is none. No need to worry about having two
spaces instead of one.



Spacing

Whitespaces are treated the same way as in most other programming languages:
Either there is at least one, or there is none. No need to worry about having two
spaces instead of one.

IATEX will break the line as it tries to optimize the document layout (by minimizing
badness) according to the rules of the style.

Note: This can make it hard to force a specific placement.



Spacing

Whitespaces are treated the same way as in most other programming languages:
Either there is at least one, or there is none. No need to worry about having two
spaces instead of one.

IATEX will break the line as it tries to optimize the document layout (by minimizing
badness) according to the rules of the style.

Note: This can make it hard to force a specific placement.

Horizontal and vertical space can be added with the \hspace and \vspace
commands. They both take one parameter; a distance.



Spacing > Horizontal Space

first\hspace{lcm}last

first

last




Spacing > Vertical Space

first

\vspace{lcm}
last

first

last




Formatting

normal \\
\textbf{bold} \\
\textsl{slanted} \\
\textit{italics} \\
\texttt{teletype} \\
\textsl{serif freel} \\
\underline{underline}

normal
bold
slanted
italics
teletype
serif free

underline




Text Size

\tiny{Sample text}
\scriptsize{Sample text}
\footnotesize{Sample text}
\small{Sample text}
\normalsize{Sample text}
\large{Sample text}
\Large{Sample text}
\LARGE{Sample text}
\huge{Sample text}
\Huge{Sample text}

Sample text Sample text Sample text Sam-
ple text Sample text Sample text
Sample text Sample text
Sample text Sample
text




Listings



Listings

General considerations when deciding between ordered or unordered lists:

mentioned
the number
of items?

need to
refer to a
specific
item?

use enumerate environment

use itemize environment




Listings > Itemization

\begin{itemize}
\item Rust
\item Elixir
\item Python
\item \LaTeX 7

\end{itemize}

Programming languages:

Programming languages:
» Rust
» Elixir
» Python
> IATEX?




Listings > Enumerations

\begin{enumerate}
\item Rust
\item Elixir
\item Python
\item \LaTeX 7

\end{enumerate}

Programming languages:

Programming languages:

1

Rust

2. Elixir
3
4. IATEX?

Python
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References

Numbered things can be labeled and referenced by their number or their page.

These include:
» Section at any level of depth.
» Figures and tables.
» Equations.

» Enumerated lists.

They do not include:
» Bibliography.
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References > Use

A label is created using the \1label command. This will refer to the latest numerable
construct.

The number referred to by a label can be accessed using the \ref command. Be sure
to preface it with something that indicates what you are referring to (e.g., a section).

The page number containing a label can be accessed using the \pageref command.

Note: References need two parses of the IATEX compiler to function:
> First pass notes down the position of the labels.

» Second pass inserts these positions at the references.



References > Example

Algorithm: _

\begin{enumerate} Algorithm:
\item Initialize. 1. Initialize.
\item \label{id} Do stuff. 2. Do stuff.

\item Go to step \ref{id}.

3. Go to step 2.
\end{enumerate}




Colors

/% -- preample

\usepackage{color}

/% -- main matter

Text can be colored!
Colors can be l
And they can be declared inline!

\definecolor{myfavcolor}{rgb}{0.49,0.79,0.62}

Text can be \textcolor{purple}{colored}!

Colors can be
\textcolor{myfavcolor}{customized}!

And they can be declared
\textcolor{red!27!green}{inline}!

IATEX provides a set of predefined color names: https://latexcolor.com


https://latexcolor.com

Colors > Predefined

latexcolor.com,

Swatch

Color name=

Air Force blue

Alice blue

Alizarin

Almond

Amaranth

Amber

Amber (SAE/ECE)

Hex
Triplet
*RGB

#5D8AA8

#FOFSFF

#E32636

#EFDECD

#E52B50

#FFBFOO

#FF7E00

IATEX

\definecolor{airforceblue}{rgh}{06.36,
0.54, 0.66}

\definecolor{aliceblue}{rgb}{0.94,
0.97, 1.0}
\definecolor{alizarin}{rgb}{0.82, 0.1,
0.26}

\definecolor{almond}{rgb}{0.94, 0.87,
0.8}

\definecolor{amaranth}{rgb}{0.9, 0.17,
0.31}

\definecolor{amber}{rgb}{1.0, 0.75,
0.0}

\definecolor{amber(sae/ece)}{rgb}{1.0,
0.49, 0.0}

ATEX Color

m = - o x

Great day! Welcome to a
teeny tiny corner of the vast
interwebs. My hope is that
‘you find this particular
comer useful. | got tired of
hunting down color codes
and syntax, saw that there
were a surprising number of
searches for "latex color,"
whence the solution
seemed obvious.

Believe it or not, you can
leave a comment below,
courtesy of the fine folks
from Disqus.
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\begin{tabular}{ }

\end{tabular}



Arranging Tabular Data > Environment

Format Definition

\begin{tabular}{[ %
| [« Data

\end{tabular}
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The format definition specifies how to arrange the cells of a single row, and where to
place vertical lines.

Consider the row data a queue of cells.

Options include:
» “|" Place a vertical bar.
“1" Consume a cell and left justify its contents.

| 2
> “c"” Consume a cell and center its contents.
» “r" Consume a cell and right justify its contents.



Arranging Tabular Data > Format Definition

The format definition specifies how to arrange the cells of a single row, and where to
place vertical lines.

Consider the row data a queue of cells.

Options include:

> “|" Place a vertical bar.

> “1" Consume a cell and left justify its contents.

> “c” Consume a cell and center its contents.

» “r" Consume a cell and right justify its contents.

> “p{5cm}” Consume a cell and make a (multi-line) paragraph out of its contents.
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that:
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» Each row needs to be terminated by a manual linebreak( | \).



Arranging Tabular Data > Data

In the data segment we have a sequence of horizontal lines (\hline) and rows of data.

A row of data needs to respect the format of the tabular environment. This means
that:
» The cell contents needs to be separated by a & character.

» Each row needs to be terminated by a manual linebreak( | \).

Cells can be merged and their background colored. For this, use search terms like
“multirow”, “multicol” and “cell color”.



Arranging Tabular Data > Example

\begin{tabular}{|1lrr|}
\hline
\textbf{Country} & \textbf{Area/[$km~2$]1} & \textbf{Population} \\
\hline
Denmark & 43.094 & 6.001.008 \\
Greece & 131.957 & 10.400.720 \\
Finland & 338,455 & 5.635.971 \\
\hline
\end{tabular}



Arranging Tabular Data > Result

Country Area/[km’] Population

Denmark 43.094 6.001.008
Greece 131.957 10.400.720
Finland 338,455 5.635.971
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Bitmapped
Includable
Native

X
X
X
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Lossy
Vector

JPEG

PNG

X
X
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Bitmapped
Includable
Lossy
Vector
Native

JPEG

X
X
X

PNG

X X SVG

X
X
I I I o

XX x PDF



Including Visuals

When it comes to visual aids, IATEX supports a number of different types.

Bitmapped
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Including Visuals

When it comes to visual aids, IATEX supports a number of different types.

Bitmapped
Includable
Lossy
Vector
Native

JPEG

X
X
X

NG

X
X

SVG

X X X D

X X X X TikZ

X
X
o o
Format
A



Including Visuals > PDF Graphics

\includegraphics [width=45mm] {
./figs/vector.pdf
}




Including Visuals > SVG Graphics

While that figure was included as a PDF file, it was created as an SVG file using
Inkscape: https://inkscape.org


https://inkscape.org

Including Visuals > SVG Graphics

While that figure was included as a PDF file, it was created as an SVG file using
Inkscape: https://inkscape.org

There is, however, no native process for including an SVG file in IATEX.


https://inkscape.org

Including Visuals > SVG Graphics

While that figure was included as a PDF file, it was created as an SVG file using
Inkscape: https://inkscape.org
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$ inkscape ./figs/vector.svg -z -D -o ./figs/vector.pdf

That line is straight out of the build system for this presentation.
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Including Visuals > SVG Graphics

While that figure was included as a PDF file, it was created as an SVG file using
Inkscape: https://inkscape.org

There is, however, no native process for including an SVG file in IATEX.

Instead, we can use Inkscape to convert it to PDF:

$ inkscape ./figs/vector.svg -z -D -o ./figs/vector.pdf

That line is straight out of the build system for this presentation.

And the SVG file, in its entirety, looks like this ..


https://inkscape.org

Including Visuals > SVG Source

<?zml version="1.0" encoding="UTF-8" standalone="no"?>
<!-- Created with Inkscape (http://www.inkscape.org/) ——>

<svg
width="50mm"
height="50mm"
viewBox="0 0 50 50"
id="SVGRoot"
version="1.1"

1.4 (e7c3feb100, 2024-10-09)"

ttp://wuw.inkscape.org/namespaces/inkscape"
xmlns:sodipodi=
xmlns="http://www.w3.o0rg/2000/svg"
xmlns:svg="http://www.w3.org/2000/svg">
<sodipodi:namedview

inkscape: cx="94.278559"
inkscape:c
id="namedview1"

pagecolor: fEFEEE"
bordercolor="#000000"
borderopacit; 0.25"

inkscape: showpageshadow="2"
inkscape:pageopacity="0.0"
inkscape: pagecheckerboard=
inkscape:deskcolor="#d1d1d1"
inkscape:window-width="1920"
inkscape:window-height="1131"
inkscape:
inkscape:
inkscape:window-maximized="1"
inkscape: current-layer="1layeri"
showgrid="true">
<inkscape:grid
id="grid1"
units="mm"

http://sodipodi.sourceforge.net/DTD/sodipodi-0.dtd"

originx="0"
originy="0"
spacingx="0.1"
spacingy="0.1"
empcolor="#0099e5"
empopacity="0.30196078"
color="#0099e5"
opacity="0.14901961"
empspacing="10"
enabled="true"
visible="true" />
</sodipodi :namedview>
<defs
id="defs1" />
<g
inkscape:label="Layer 1"
inkscape : groupmode="1layer"
id="layer1">

14.999999"
ry="15" />
<path
style="fill:none;stroke:#000000;stroke-width:0.264583"
‘m 10,25 ¢ 15,5 20,0 15,-15"
id="path4"
sodipodi:nodetypes="cc" />
<path
style="fill:#fff££f;stroke:#000000;stroke-width:0.264583"
d="M 25,25 35.600001,35.600001"
id="path5"
sodipodi:nodetypes="cc" />

</g>
</svg>



Including Visuals > Bitmapped Graphics



Including Visuals > Bitmapped Graphics
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\includegraphics [width=45mm] {
./figs/dscf0013016.png

}
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Floats

When writing a report, you should expect your reader to follow the main track of the
text. It should be possible to read it from beginning to end.

But at times you may want to provide extra materials though figures and tables. These
should not break the flow of the text.

Instead, they should exists outside the flow of the text, and be referenced. The
typesetting system should find space for them closeby, at a location where they don't
break the flow.

In short, they should float.
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Floats > Figures and Tables

You define a figure like this:

\begin{figurel} [tbp]
/i contents goes here
\caption{Description of figure}
\label{fig:tag}

\end{figure}

You define a table like this:

\begin{table} [tbp]
/i contents goes here
\caption{Description of table}
\label{table:tag}

\end{table}
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\begin{figure} What about this?
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These are the positioning instructions. It instructs IATEX where it is allowed to place
the float. It supports the following codes:

> “t" Float can be placed at the top of a page.

» “b" Float can be placed at the bottom of a page.
> “p" Float can be placed at a page with nothing but floats.
> “h" Float should be placed approximately here.
>

Override internal parameters that IATEX uses to determine good positions.



Floats > Positioning
\begin{figure} What about this?
/4 contents goes here
\caption{Description of figure}
\label{fig:tag}
\end{figure}

These are the positioning instructions. It instructs IATEX where it is allowed to place
the float. It supports the following codes:

> “t" Float can be placed at the top of a page.

» “b" Float can be placed at the bottom of a page.
> “p" Float can be placed at a page with nothing but floats.
> “h" Float should be placed approximately here.
>

Override internal parameters that IATEX uses to determine good positions.

In general, avoid the latter two.



Footnotes

Text\footnote{Short
detailing.}.

Text?.

“Short detaining.




Margin Paragraphs
Margin paragraphs works in much the same way as footnotes.
However, they are (i) not numbered, and (ii) appear in the outer margin.

Instead of the \footnote command you use \marginpar (and make sure that the
marginnote package is included).

o @ 7z report-writing.pdf

5.5.5 Citations

Each statement we make represent some thoughts. If those thoughts are yours,

then you should get credit for them. If they are not, then you need to give credit
credit. Otherwise, you will be stealing their work. Conveniently, this mecha-

nism also allows you to not build up your argument from zero. Zero being the

level that is generally accepted as truth amongst your peers.

“If I have seen further it is by standing on the shoulders of Giants.” Isaac Newton
Isaac Newton[26]

Every statement must be mapped to an owner. If a statement is not explicitly



Code Inclusion

There is a number of packages for including code. In this presentation we will look at
minted.

The minted package support a long list of file format, and even things like shell
interactions.

It also support various forms of highlights and line numbering.



Code Inclusion > Inline

The formatting of a function
call in rust looks like this:
\mintinline{rust}{fun(1+1)}.

The formatting of a function call in
rust looks like this: fun(1+1).




Code Inclusion > Environment

The code could look like this:

\begin{minted}{elixir}
doubles =

[1,2,3,4]

|> Enum.map(fn value -> value*2 end)
\end{minted}

And that's not too bad, right?

The code could look like this:

doubles =
[1,2,3,4]
[> Enum.map(fn value -> value*2 end)

And that’s not too bad, right?
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Mathematics

One of the things IATEX is know for is its ability to typeset mathematical expressions.

At first, it can be quite daunting to remember the syntax and code for all the different
constructs.

But the reality is that there is a system behind the madness, and the set of constructs
you are going to be using on a daily basis is very small and easily remembered.

For instance, the command for producing a fraction is called \frac and takes two
parameters: First a nominator, and then a denominator. The \sqrt command
produces a square root symbol and takes one parameter.

And the web is littered with tables containing codes for Greek letters and all kinds of
weird symbols. Just do an image search.



Mathematics > Inline

The Pythagorean theorem
states that $a~2+b~2 = c-2§, The Pythagorean theorem states that

2 2 _ 2 _
but can also be expressed as &A= e b%} cag also be ex
$c = \sqrt{a"2+b"2}$. pressed as ¢ = V'a“ + b=




Mathematics > Equations

\begin{alignx*}
a”2 &= b2 + c”2 \Leftrightarrow \\ 32 _ b2 + C2 PN
a &= \sqrt{b"2 + c"2}

\end{align*} a=+/b24 2




Mathematics > Equation References

\begin{align}
\label{pythi}
a”2 &= b~2 + c¢”2 \Leftrightarrow \\
\label{pyth2}

a &= \sqrt{b"2 + c"2}
\end{align}
Pythagoras can be expressed as
either of equations \ref{pythl}
or \ref{pyth2}.

aZ2=bp+’e (1)
a=1b2+c? (2)

Pythagoras can be expressed as either of
equations 1 or 2.




Mathematics > Raising and Lowering Text

Water is $H_20%. .
Water is Hy O.

$H_{20}$ is not a thing. Hag is not a thing.
The square of three is 32.

The square of three is $3728%.




URLs

Search at
\textcolor{blue}{
\texttt{https://search.brave.com}
} Search at https://search.brave.com
Search at Search at https://search.brave.com

\url{https://search.brave.com}
. Search at Brave

Search at
\href{https://search.brave.com}{Brave}



https://search.brave.com
https://search.brave.com

Nooks and Crannies

The \1dots can be used to add three periods ..

Just as the \LaTeX command, it will eat any following space. If this is not what you
want, then you have to escape the following space with a backslash.

The center environment and a \centering command can be used to center elements.
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When constructing the table of contents (aka ToC), we can decide how deep we want
it to follow into the documents section tree.
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\setcounter{tocdepth}{2}

Alternatively, we can omit this.
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Table of Contents

When constructing the table of contents (aka ToC), we can decide how deep we want
it to follow into the documents section tree.

If we want to include subsections, then we set the tocdepth counter to 2:
\setcounter{tocdepth}{2}

Alternatively, we can omit this.

The ToC itself can be placed using this command:

\tableofcontents

Note: All of this goes into the front matter of the document.



List of Figures and Tables

A list of figures can be inserted using the command:

\listoffigures

A list of tables can be inserted using the command:
\listoftables
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Bibliography

When writing, we need to give and to take credit for the individual parts that make up
our work.

» We build on what others have accomplished, and give them credit for their work.

> We come up with new insights, and take credit for those.

In order to give credit to some work, we cite it.

IATEX has an extensive framework for working with such citations.



Bibliography > Database Population

< (¢] & https://dl.acm.org/doi/10.1145/1098918.1098925 * @ =

Browse | About | Signin Register

Journals Magazines Proceedings Books SIGs Conferences People

Conference  Proceedings  Upcoming Events  Authors  Affiliations  Award Winners

Home > Conferences > SENSYS > Proceedings > SenSys '05 > A macroscope in the redwoods
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Bibliography > Database Population

@ https:/dl.acm.org/doi/10.1145/1098918.1098925 * m = - &8 x

Export Citations

BibTeX

@inproceedings{10.1145/1098918.1098925,

author = {Tolle, Gilman and Polastre, Joseph and Szewczyk,
Robert and Culler, David and Turner, Neil and Tu, Kevin and
Burgess, Stephen and Dawson, Todd and Buonadonna, Phil and
Gay, David and Hong, Wei},

title = {A macroscope in the redwoods},

year = {2005},

isbn = {159593054X},

publisher = {Association for Computing Machinery},

address = {New York, NY, USA},

url = {https://doi.org/10.1145/1098918.1098925},

doi = {10.1145/1098918.1098925},

abstract = {The wireless sensor network "macroscope” offers

¢ Feedback
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Bibliography > Database

@inproceedings{10.1145/1098918.1098925,

author = {Tolle, Gilman and Polastre, Joseph and Szewczyk, Robert and Culler, David and Turner, Neil and Tu, Kevin and

< Burgess, Stephen and Dawson, Todd and Buonadonna, Phil and Gay, David and Hong, Weil},

title = {A macroscope in the redwoods},

year = {2005},

isbn = {159593054X},

publisher = {Association for Computing Machinery},

address = {New York, NY, USA},

url = {https://doi.org/10.1145/1098918.1098925},

doi = {10.1145/1098918.1098925},

abstract = {The wireless sensor network "macroscope" offers the potential to advance science by enabling dense temporal and
spatial monitoring of large physical volumes. This paper presents a case study of a wireless sensor network that
recorded 44 days in the life of a 70-meter tall redwood tree, at a density of every 5 minutes in time and every 2
meters in space. Each node measured air temperature, relative humidity, and photosynthetically active solar radiation.
The network captured a detailed picture of the complex spatial variation and temporal dynamics of the microclimate
surrounding a coastal redwood tree. This paper describes the deployed network and then employs a multi-dimensional
analysis methodology to reveal trends and gradients in this large and previously-unobtainable dataset. An analysis of
system performance data is then performed, suggesting lessons for future deployments.},
booktitle = {Proceedings of the 3rd International Conference on Embedded Networked Sensor Systems},
pages = {51-63},
numpages = {13},
keywords = {wireless sensor networks, microclimate monitoring, macroscope, application analysis},
location = {San Diego, California, USA},
series = {SenSys '05}

o

PELLLL]



Bibliography > Database

Remember this!
@inproceedingsi10A1145/1098918.10989251
author = {To 5 > Joseph and Szewczyk, Robert and Culler, David and Turner, Neil and Tu, Kevin and

< Burgess, Stephen and Dawson, Todd and Buonadonna, Phil and Gay, David and Hong, Weil},

title = {A macroscope in the redwoods},

year = {2005},

isbn = {159593054X},

publisher = {Association for Computing Machinery},

address = {New York, NY, USA},

url = {https://doi.org/10.1145/1098918.1098925},

doi = {10.1145/1098918.1098925},

abstract = {The wireless sensor network "macroscope" offers the potential to advance science by enabling dense temporal and
spatial monitoring of large physical volumes. This paper presents a case study of a wireless sensor network that
recorded 44 days in the life of a 70-meter tall redwood tree, at a density of every 5 minutes in time and every 2
meters in space. Each node measured air temperature, relative humidity, and photosynthetically active solar radiation.
The network captured a detailed picture of the complex spatial variation and temporal dynamics of the microclimate
surrounding a coastal redwood tree. This paper describes the deployed network and then employs a multi-dimensional
analysis methodology to reveal trends and gradients in this large and previously-unobtainable dataset. An analysis of
system performance data is then performed, suggesting lessons for future deployments.},

booktitle = {Proceedings of the 3rd International Conference on Embedded Networked Sensor Systems},

pages = {51-63},

numpages = {13},

keywords = {wireless sensor networks, microclimate monitoring, macroscope, application analysis},

location = {San Diego, California, USA},

series = {SenSys '05}

o

PELLLL]
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Bibliography > Citation and Bibliography Generation
Assuming that you have that database stored in references.bib, put the following in
your preample:

\usepackage [

backend=biber,
J{biblatex}
\addbibresource{references.bib}

Now you can start citing your statements:
Some profound statement\cite{10.1145/1098918.1098925}.

We can then add the bibliography in the back matter:
\printbibliography

In between the first and the later runs of IATEX, make sure to run the following
command:

biber document.bcf
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Index

At its core, an index allows us to look up a term and get a set of pages relevant for
that term.

To tag a position for inclusion in the index under a specific term, use the command:
\index{Term}

At the back matter of your document, then add:

\printindex

In between the first and the later runs of IATEX, make sure to run the following
command:

makeindex document.idx

It will generate your index.
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Locating the Error

Unfortunately, IATEX errors are notorious for being hard to reason about.
Often, the line number does not reflect the actual line in the source file.
Because of this, | frequently build the document.

If in doubt, use binary search by commenting out large blocks of code to locate the
issue.
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Googling the Error
Most errors are easily googleable, and will yield hits on sites like StackOverflow.

In order to get good results, you should:
» Carefully consider which part to copy paste in. These errors can be verbose.
» Consider the type of error.

> Try to figure out what could cause such an error, and figure out whether these
conditions apply to you.

» Don't be afraid to take an extra step down the rabbit hole.
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General Resources

Wide resources:
> WikiBooks LaTeX: https://en.wikibooks.org/wiki/LaTeX

» Overleaf Learn: https://www.overleaf.com/learn
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General Resources

Wide resources:
> WikiBooks LaTeX: https://en.wikibooks.org/wiki/LaTeX

» Overleaf Learn: https://www.overleaf.com/learn

Code generators:
» Table generator: https://www.tablesgenerator.com/latex_tables
» Equation editor: https://latexeditor.lagrida.com

Misc:
» TikZ: https://tikz.dev


https://en.wikibooks.org/wiki/LaTeX
https://www.overleaf.com/learn
https://www.tablesgenerator.com/latex_tables
https://latexeditor.lagrida.com
https://tikz.dev

Source and Templates

The source code for these slides can be found here:
https://github.com/aslakjohansen/prosa-latex
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Source and Templates

The source code for these slides can be found here:
https://github.com/aslakjohansen/prosa-latex

Templates for reports and presentations can be found here:
https://github.com/aslakjohansen/latex-template

More material will appear at https://latex.asjo.dk


https://github.com/aslakjohansen/prosa-latex
https://github.com/aslakjohansen/latex-template
https://latex.asjo.dk
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Exercises

1. New Project: Create a new project (on Overleaf, GitHub or similar). Make sure
that you have a report IATEX document that builds.

2. Tabular Data: Find some tabular data, place it in a tabular environment, and
make it look pretty.

3. Formula: Pick any formula (e.g., the discrete fourier transformation), and express
it though IATEX code.

4. Report: Pick any old report, and port it to IATEX. The point is not to go through

the whole report, but rather to get a feel of (i) the effort needed to port an old
report, and (ii) the perceived typographical quality per effort.
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